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Getting Started 
This documentation explains how to use WordPress, the Sequanota theme, and some of the 

plugins installed on https://sequanota.com. Depending on your experience level, you may not 

need to read all of this. If you’ve used WordPress before you can skip the Basics of WordPress 

section. This section provides a brief overview of WordPress’ many features. The sections 

following provide more detailed instructions for using specific plugins installed on this site. I 

would encourage you to read those sections thoroughly before attempting to make changes to 

the site. 

Quick Links 
Here are some quick links to popular topics: 

• Creating a Page 

• Creating a Post 

• Editing a Page 

• Editing a Row 

• Editing a Widget 

• Editing Menus Using the Customizer 

• Editing the Footer 

• Row Styles 

• Styling Best Practices 

• Widget Styles 

• Widgets (Bootstrap Widgets Bundle) 

• Widgets (SiteOrigin Widgets Bundle) 

Contact the Developer 
If you are experiencing problems with the site or need help and you’ve read this 

documentation, feel free to email the site’s developer at n.belsterling@gmail.com for help. 

  

https://sequanota.com/
mailto:n.belsterling@gmail.com
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Basics of WordPress 
WordPress is the platform this site is built on. It handles all the back-end work to make the site 

easy to edit and looking beautiful. Below is a brief overview of how to use WordPress. For more 

detailed documentation use the Recommended Resources or visit 

https://codex.wordpress.org/WordPress_Lessons. 

Logging In 
To access the sites admin panel and other administrative features you’ll first need to login. 

Navigate to https://sequanota.com/login and enter your username and password. The backup 

administrative account’s credentials are as follows: 

Email: admin@sequanota.com 
Username: admin 
Password: @E$tj7pj809rC%JDay 
 

When you’re done entering your Username or Email and Password click Log In. If you forget 

your password, click the Lost your password? at the bottom of the login page. 

Creating a New User Account 
It’s a good idea for everyone using the site to have their own user account. This allows you to 

limit certain user’s permissions and to better record changes. Overall, it’s just a good idea for 

security. To make a new account navigate to the dashboard and click Users then Add New or 

navigate to https://sequanota.com/wp-admin/user-new.php. Pick a Username for the new 

user. The username cannot be changed once the account has been created. Next add a valid 

Email address. You can fill in the First Name, Last Name, and Website fields if you want but 

they’re not required. Next click Show Password and either type your own or copy the generated 

password. You can choice to send an email with the password to the new user. Next, you pick 

the user’s role. Here is a description of each: 

Administrator – Full Access to Dashboard and All Site Settings 
Editor – Full Access to Posts, Pages, Comments, and Media 
Author – Access to their Posts, Comments, and Media 
Contributor – Access to Suggest Edits to Posts 
Subscriber – No Special Permissions 
 

Finally, you have the option to upload an Image to be used as a profile picture. Once you’re all 

done, click Add New User. 

https://codex.wordpress.org/WordPress_Lessons
https://sequanota.com/login
https://sequanota.com/wp-admin/user-new.php
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Using the Dashboard 
The dashboard is where you’ll make changes to your WordPress site. To get to the dashboard, 

hover over Sequanota (the Site Title) on the admin bar which shows up at the top of every page 

once you’re logged in then click Dashboard. Alternatively, you can navigate to 

https://sequanota.com/admin. On the left side of the dashboard you’ll see the dashboard’s 

navigation menu. This is where you’ll access pages on the dashboard. On the top right of most 

pages on the dashboard you’ll see two buttons Screen Options and Help. If you click Screen 

Options, you’ll see customized options for each screen. Usually these options will allow you to 

show or hide settings on those screens. If you click Help, you’ll see WordPress’ help and more 

detailed information than this manual. If you need additional help on the dashboard, these 

additional resources should be extremely helpful. 

Dashboard Home (Dashboard → Home) 
This page is full of helpful links to other pages and content on the dashboard but it itself has no 

special functionality. To customize the boxes on this page, click Screen Options at the top right 

of the screen. 

Recommended Resources: 

https://codex.wordpress.org/Dashboard_Screen 

Updating WordPress (Dashboard → Updates) 
Use this page to update plugins, themes, and WordPress. If a new version of WordPress is 

available, click Update Now to update. If you want to update a plugin or theme, select the 

plugins/themes you wish to update and then click Update Plugins/Update Themes. When 

WordPress, plugins, or themes are updating, do not close your web browser until they finish. 

Recommended Resources: 

https://codex.wordpress.org/Dashboard_Updates_Screen 

Managing Posts (Posts → All Posts) 
This page allows you to create, edit, view, and delete posts. Posts are designed for blog posts or 

other timely content. To create a post, click Add New at the top. For everything else, simply 

hover over the desired post and click Edit, Quick Edit, Trash, or Delete. Quick edit is useful for 

changing information associated with a post. All deleted posts are kept in the Trash until 

deleted permanently. 

Recommended Resources: 

https://codex.wordpress.org/Posts_Screen 

https://sequanota.com/admin
https://codex.wordpress.org/Dashboard_Screen
https://codex.wordpress.org/Dashboard_Updates_Screen
https://codex.wordpress.org/Posts_Screen
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Categories (Posts → Categories) 
Here is where you manage categories. Categories allow you to organize and group similar posts. 

They generate a page to view all posts in the category. 

Recommended Resources: 

https://codex.wordpress.org/Posts_Categories_Screen 

Tags (Posts → Tags) 
This page is for managing tags. Tags have the same functionality as categories. They only differ 

from categories in the way they are implemented by you. Tags are meant to describe specific 

details of your posts but are not meant to organize them. Tags will also automatically be 

created if they are added to a post and don’t already exist. 

Recommended Resources: 

https://codex.wordpress.org/Posts_Tags_Screen 

Media (Media → Library) 
Here is where you manage all media content on the site. You can upload content here by 

clicking Add New or you can upload from posts, pages, or widgets. Clicking on an image or other 

media opens a preview of the attachment. On the right side of the preview you can change its 

Title, Caption, Alt-Text, and Description. Underneath that are links to View attachment page, 

Edit more details, or Delete permanently. There is no recycle bin for media. Under the preview 

for images is an Edit Image button that allows you to crop, rotate, or resize the image. 

Recommended Resources: 

https://codex.wordpress.org/Media_Library_Screen 

Managing Pages (Pages → All Pages) 
Here you can create, edit, view, and delete pages. Pages are meant for static and timeless 

content. To create a page, click Add New at the top. For everything else, simply hover over the 

desired page and click Edit, Quick Edit, Trash, or Delete. Quick edit is useful for changing 

information associated with a page. All deleted pages are kept in the Trash until deleted 

permanently. 

Recommended Resources: 

https://codex.wordpress.org/Posts_Screen 

https://codex.wordpress.org/Posts_Categories_Screen
https://codex.wordpress.org/Posts_Tags_Screen
https://codex.wordpress.org/Media_Library_Screen
https://codex.wordpress.org/Posts_Screen
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Managing Comments (Comments) 
Comments are created when someone comments on a post. Comments must be enabled in a 

post’s settings to be added to it. You can Approve or Unapprove, Reply, Quick Edit, Edit, Spam, 

or Trash comments here. Both Spam and Trash comments aren’t deleted until Delete 

Permanently is clicked. Comment moderation settings can be changed on the Discussion 

Settings page (Settings → Discussion) or by navigating to https://sequanota.com/wp-

admin/options-discussion.php. 

Recommended Resources: 

https://codex.wordpress.org/Administration_Screens#Comments 

https://codex.wordpress.org/Comments_Screen 

https://codex.wordpress.org/Comment_Spam 

Themes (Appearance → Themes) 
Themes control how your pages, posts, and everything else on your site look. You’re currently 

using a custom theme that was created for Sequanota so no need to worry about changing 

themes. 

Recommended Resources: 

https://codex.wordpress.org/Using_Themes 

Theme and Site Customization (Appearance → Customize) 
This can either be access from the dashboard or by clicking Customize on the admin bar at the 

top of the site. This will open a preview of your site and gives you the ability to edit and test out 

new themes, site information, menus, theme options, widgets, and more. Don’t worry, if you 

close this without clicking Publish none of the changes will affect the site so feel free to try new 

things. 

Under Site Identity you can change the Site Title, Tagline, and Site Icon. 

Under Menus you’ll see all the menus on the site and where on the theme they’re applied. 

Menus are used for the site’s navigation and are usually shown of the top of every page. Click a 

menu to edit, reorder, delete, or add to its menu items. For more details on using the 

customizer to edit menus see Editing Menus Using the Customizer. 

Under Theme Options you can customize the site’s Navigation Color, Footer Color, Back to Top 

Button Color, and Donate Button Link. 

Under Widgets you can edit the footer of the site. Simply click the on the Layout Builder and 

click Open Builder. For more details on the Layout Builder see Using Page Builder by SiteOrigin. 

For more in-depth instructions on changing the footer see Editing the Footer. 

https://sequanota.com/wp-admin/options-discussion.php
https://sequanota.com/wp-admin/options-discussion.php
https://codex.wordpress.org/Administration_Screens#Comments
https://codex.wordpress.org/Comments_Screen
https://codex.wordpress.org/Comment_Spam
https://codex.wordpress.org/Using_Themes
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Recommended Resources: 

https://codex.wordpress.org/Appearance_Customize_Screen 

Plugins (Plugins → Installed Plugins) 
Plugins are used to add additional features to a WordPress site. They can do all sorts of things. 

This WordPress site has several plugins installed. Here is a list of some of them and what they 

do. 

Page Builder by SiteOrigin – Adds the Page Builder feature to pages. 
SiteOrigin Widgets Bundle – Adds Widgets Bundle widgets to be used with Page Builder. 
Bootstrap Widgets Bundle – Adds Bootstrap Widgets to be used with Page Builder. 
TinyMCE Advanced – Adds advanced features to all text editors in WordPress. 
TinyMCE Visual Blocks – Adds visual HTML blocks to all text editors in WordPress. 
Stream – Used for logging changes made to the site and its settings. 
Google XML Sitemaps – Creates a sitemap for Google and other search engines. 
Comments Deeper – Provides the styling and ability to comment for this and other themes. 
Duplicator – Creates backups of the entire site to be downloaded and reinstalled if needed. 
 

You can always add a plugin by clicking Add New at the top. Once downloaded, plugins also 

must be activated to be used. You must deactivate a plugin before it can be deleted. You can 

also update plugins from this screen. After updating plugins, check that the site still functions 

properly as plugin updates have been known to cause issues. 

Recommended Resources: 

https://codex.wordpress.org/Managing_Plugins#Plugin_Management 

Users (Users → All Users) 
Users can login to the site and edit content based on their role. This page allows you to Edit, 

View, and Delete users. You can’t delete yourself and only other Administrators can see this 

page. For more details on creating a new user see Creating a New User. 

Recommended Resources: 

https://codex.wordpress.org/Users_Screen 

https://codex.wordpress.org/Roles_and_Capabilities 

Import Tools (Tools → Import) 
Here are some tools that can be installed to import content from other sources. 

Recommended Resources: 

https://codex.wordpress.org/Tools_Import_Screen 

https://codex.wordpress.org/Appearance_Customize_Screen
https://codex.wordpress.org/Managing_Plugins#Plugin_Management
https://codex.wordpress.org/Users_Screen
https://codex.wordpress.org/Roles_and_Capabilities
https://codex.wordpress.org/Tools_Import_Screen
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Export Tools (Tools → Export) 
Here are some tools that can be installed to export content from your site. If you’re looking to 

create a backup of your site, I’d recommend using a plugin like Duplicator. 

Recommended Resources: 

https://codex.wordpress.org/Tools_Export_Screen 

Settings 
Under the settings section, you’ll find all sorts of WordPress settings and often settings for 

plugins too. Here’s a list of resources that explain every setting: 

https://codex.wordpress.org/Settings_General_Screen 

https://codex.wordpress.org/Settings_Writing_Screen 

https://codex.wordpress.org/Settings_Reading_Screen 

https://codex.wordpress.org/Settings_Discussion_Screen 

https://codex.wordpress.org/Settings_Media_Screen 

https://codex.wordpress.org/Settings_Permalinks_Screen 

Recommended Resources: 

https://codex.wordpress.org/Using_Permalinks 

The Admin Bar 
The admin bar is only visible to signed in users and offers navigation to administrative parts of 

the site. Not all buttons listed below are visible from all pages. 

The WordPress icon at the top left links to resources such as WordPress’ site, documentation, 

support forums, and feedback. 

The Dashboard button offers quick links to the dashboard, themes, widgets, and menus. 

The Sequanota (the Site Title) button takes you to the homepage of your site. 

The Customize button opens a preview of the site and provides easy editing of the site identity, 

navigation menus, theme options, widgets, and more. See Theme and Site Customization 

(Appearance → Customize) for more details on the customizer. 

An Update icon will appear if WordPress, a plugin, or a theme update is available. Clicking on 

the icon will take you straight to the Updates page. See more on Updating WordPress 

(Dashboard → Updates). 

The Comments icon displays the number of comments awaiting approval. Clicking on the icon 

will take you straight to the Comments page. For more details on comments see Managing 

Comments (Comments). 

https://wordpress.org/plugins/duplicator/
https://codex.wordpress.org/Tools_Export_Screen
https://codex.wordpress.org/Settings_General_Screen
https://codex.wordpress.org/Settings_Writing_Screen
https://codex.wordpress.org/Settings_Reading_Screen
https://codex.wordpress.org/Settings_Discussion_Screen
https://codex.wordpress.org/Settings_Media_Screen
https://codex.wordpress.org/Settings_Permalinks_Screen
https://codex.wordpress.org/Using_Permalinks
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The New button provides quick links to create a new post, media, page, or user. For more 

details on creating new content see Creating a Post, Media (Media → Library), Creating a Page, 

or Creating a New User Account. 

The Edit Post/Edit Media/Edit Page button will show on post/media/or pages. If clicked, it will 

take you straight to that content’s editor. For more details on editing content see Editing a Post 

or Editing a Page. 

The View Post/View Media/View Page button will show on the post/media/or page’s editor. If 

clicked, it will take you straight to that content’s live page. 

The Live Editor is part of the Page Builder by SiteOrigin plugin and will take you straight to the 

Page Builder Live Editor. For more on the Live Editor see Live Editor. 

Hovering over your username on the top right will give you quick links to Edit My Profile or Log 

Out. 

The Search icon allows you to search the site. 

Creating a Post 
To create a post, navigate to the All Posts screen (Posts → All Posts) and click Add New or 

navigate straight to the Add New Post screen (Posts → Add New). Give it a name and a 

permalink (or URL) will automatically be created. You can change this URL by clicking Edit next 

to the permalink. Next, you’ll create the posts content. Specifics for creating content and 

editing post’s settings are listed under Editing a Post because the procedure is the same. If the 

post hasn’t been published yet, you can save it as a draft. This will keep it from showing up on 

the site so it’s useful if the post isn’t finished yet. When you’re done with the post, click Publish 

to make it visible to site visitors. 

Recommended Resources: 

https://codex.wordpress.org/Posts_Add_New_Screen 

Editing a Post 
On the Edit Post screen, you will have the ability to change all post specific settings as well as 

updating the content itself. This is the same screen you’ll get when you first create a new post 

as well. If one of the boxes described below is not visible, try changing the screen options 

located on the top right of the screen. For full documentation on writing posts visit 

https://codex.wordpress.org/Posts_Add_New_Screen. 

Picking a Title 
The title of a post should accurately describe the main idea of the post and should be as few 

words as possible. You just want enough information here to catch the reader’s attention. 

https://codex.wordpress.org/Posts_Add_New_Screen
https://codex.wordpress.org/Posts_Add_New_Screen
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Changing the Permalink 
The permalink (or URL) is the link others need to find this post on your site. You want to keep 

this especially short. I’d recommend not editing this, especially after you’ve published the 

post. If you are to edit it, replace spaces with a hyphen (“-”) and keep it straight and to the 

point. Also, this permalink must be unique for your site so don’t try to use another post’s or 

page’s permalink. 

Editing the Content 
To change the post’s content, simply type in the text field like you would in a word document. 

All the usual font and styling tools should be there. If you want to add an image, video, or other 

media content to your post click Add Media and select the media you wish to include. For more 

advanced users, you can click the Text tab on the top right of the text area to view the HTML 

and CSS code for the content. For the most part, you’ll probably want to stay on the Visual tab. 

If you’re using Page Builder to edit post content, you’ll need to see Using Page Builder by 

SiteOrigin to learn how to make changes. 

Enable or Disable Comments 
To allow comments check the corresponding checkbox under the Discussion box. 

Changing the Author 
You can change the author of a post by selecting them from the Author box. 

Previewing Changes 
To preview changes before publishing, you can click Preview Changes from the Publish box. 

Saving Changes 
To save any changes made to a post, you need to click Save Draft (only available on 

unpublished posts), Publish (only available on unpublished posts), or Update (for published 

posts) from the Publish box. Leaving the screen without clicking one of these three buttons 

will result in loss of all changes. 

Changing the Visibility 
Posts can be public, password protected, or private. This setting can be changed in the Publish 

box next to Visibility. 
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Adding Categories 
It’s important to categorize posts. This allows an overall organization of your site’s many posts. 

Categories can be added in the Categories box. Here you can also create new categories. More 

information on Categories are listed above. 

Adding Tags 
It’s helpful to tag posts. This allows viewers to see posts on topics they’re interested in. Tags 

can be added in the Tags box. Here you can also create new tags by simply adding them. More 

information on Tags are listed above. 

Deleting a Post 
Most of the time you won’t need to delete posts but if needed you can delete a post by clicking 

Move to Trash from the edit screen or by clicking Trash from the All Posts screen (Posts → All 

Posts). Remember, all deleted posts are kept in the Trash until deleted permanently. 

Creating a Page 
To create a page, navigate to the All Pages screen (Pages → All Pages) and click Add New or 

navigate straight to the Add New Page screen (Pages → Add New). Give it a name and a 

permalink (or URL) will automatically be created. You can change this URL by clicking Edit next 

to the permalink. Next, you’ll create the pages content. Specifics for creating content and 

editing page’s settings are listed under Editing a Page because the procedure is the same. If the 

page hasn’t been published yet, you can save it as a draft. This will keep it from showing up on 

the site so it’s useful if the page isn’t finished yet. When you’re done with the page, click 

Publish to make it visible to site visitors. Make sure you add new pages to the site’s navigation 

if needed. 

Recommended Resources: 

https://codex.wordpress.org/Pages_Add_New_Screen 

Editing a Page 
On the Edit Page screen, you will have the ability to change all page specific settings as well as 

updating the content itself. This is the same screen you’ll get when you first create a new page 

as well. If one of the boxes described below is not visible, try changing the screen options 

located on the top right of the screen. For full documentation on editing pages visit 

https://codex.wordpress.org/Pages_Screen#Editing_Individual_Pages. 

https://codex.wordpress.org/Pages_Add_New_Screen
https://codex.wordpress.org/Pages_Screen#Editing_Individual_Pages
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Picking a Title 
The title of a page should accurately describe the purpose of the page and should be as few 

words as possible. The page title will also be displayed on the navigation menu when added. 

Changing the Permalink 
The permalink (or URL) is the link others need to find this page on your site. You want to keep 

this especially short. I’d recommend not editing this, especially after you’ve published the 

page. If you are to edit it, replace spaces with a hyphen (“-”) and keep it straight and to the 

point. Also, this permalink must be unique for your site so don’t try to use another post’s or 

page’s permalink. 

Editing the Content 
If you’re using Page Builder to edit page content, you’ll need to see Using Page Builder by 

SiteOrigin to learn how to make changes. To change the page’s content, simply type in the text 

field like you would in a word document. All the usual font and styling tools should be there. If 

you want to add an image, video, or other media content to your page click Add Media and 

select the media you wish to include. For more advanced users, you can click the Text tab on 

the top right of the text area to view the HTML and CSS code for the content. For the most part, 

you’ll probably want to stay on the Visual tab. 

Enable or Disable Comments 
To allow comments check the corresponding checkbox under the Discussion box. I would not 

recommend enabling comments on pages. 

Changing the Author 
You can change the author of a page by selecting them from the Author box. 

Previewing Changes 
To preview changes before publishing, you can click Preview Changes from the Publish box. 

Saving Changes 
To save any changes made to a page, you need to click Save Draft (only available on 

unpublished pages), Publish (only available on unpublished pages), or Update (for published 

pages) from the Publish box. Leaving the screen without clicking one of these three buttons 

will result in loss of all changes. 
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Changing the Visibility 
Pages can be public, password protected, or private. This setting can be changed in the Publish 

box next to Visibility. 

Changing a Page’s Hierarchy 
Every page has a parent element. If set to (no parent) then the parent is the root of the site. For 

example, a page describing Sequanota’s history might be located at 

https://sequanota.com/about/history where the page title is History and the page’s parent is 

the About Us page. Changes to the Parent can be found in the Page Attributes box. If you want 

to manually order elements within the same parent, you can assign an order number in the 

Page Attributes box as well. 

Deleting a Page 
Occasionally you may need to delete pages. This can be done by clicking Move to Trash from 

the edit screen or by clicking Trash from the All Pages screen (Pages → All Pages). Remember, 

all deleted pages are kept in the Trash until deleted permanently. 

Editing Menus Using the Customizer 
The easiest way to edit the site’s navigation is through the customizer. To access the 

customizer, select Customize from The Admin Bar. Inside the preview on the right, you should 

see two edit buttons. Click one of these buttons and then click Edit Menu on the left customizer 

editor under the menu you wish to edit. There are two menus on this theme. There’s a Main 

Menu where most of your menu items will go and a Right Side Menu for additional links that 

will be placed next to the search button. I’d recommend placing any links to other websites on 

the Right Side Menu. After you click the Edit Menu link you should see the menu structure in 

the editor on the left. You can click on a link to edit it or delete it. You can also drag and drop 

items to reorder them. If you scroll the whole way to the bottom, you’ll see the Add Items link. 

Here you can pick from Custom Links, Pages, Posts, Categories, and Tags to insert into the 

menu. Click Add Items again to hide the dialogue. There are a couple of special navigation items 

which are described below: 

To insert a dropdown, insert a custom link with the URL set to “#” and the Navigation Label set to the name 
of the dropdown. Then insert other items and put them under that custom link. You can’t add nested 
dropdowns. 
To insert a divider, insert a custom link with the URL set to “#” and the Navigation Label set to “special-
dropdown” (case sensitive). 
 

Alternatively, you can hold the shift key and click any of the navigation links to edit them. 

https://sequanota.com/about/history
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Shortcodes 
A shortcode is a feature in WordPress that allows you to link content to a text area using short 

code and allowing WordPress and other plugins to replace it with the full code. Shortcode can 

be added to a site using the SiteOrigin Editor widget, the WordPress Text widget, or the 

WordPress Custom HTML widget. Don’t worry, you won’t need to use shortcodes very often. 

Recommended Resources: 

https://codex.wordpress.org/shortcode  

https://codex.wordpress.org/shortcode
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Using Page Builder by SiteOrigin 
Page Builder is a WordPress plugin that adds a user-friendly drag and drop editing interface to 

the posts and/or pages’ editing screen. For full documentation for this plugin visit the 

Recommended Resources or visit https://siteorigin.com/page-builder/documentation/. 

Overview 
Page Builder is a simple drag and drop editing tool for your WordPress posts and pages. The 

Layout Builder (Page Builder’s Editor) has a few buttons at the top. The Add Widget and Add 

Row buttons will open the dialogues for adding widgets and rows respectively. Layouts will give 

you access to prebuilt layouts as well as duplicating posts and pages you’ve already made. It is a 

known issue that some content might not copy correctly when duplicating posts and pages. 

(Some content in nested page builders might not transfer and will need to be added manually.) 

History will give you a complete list of changes and allows you to revert to a previous version of 

the content. Finally, the Live Preview opens the Layout Builder alongside a preview of the 

content allowing you to make edits and preview them in real time. When using Live Preview 

make sure you click Done and then Save Draft/Publish/Update to save the changes. 

Widgets 
Widgets are small blocks of content that perform a specific function. They can be customized 

and organized on the post or page to give you more control over your content. Here we’ll 

describe how to create, edit, move, duplicate, and delete widgets. For more details on editing a 

specific widget see Using the SiteOrigin Widgets Bundle or Using the Bootstrap Widgets Bundle. 

Creating a Widget 
When creating a widget, you can always click on a row’s column to select where you’d like to 

insert the widget, or you can move it once it’s been created. Next, click Add Widget and select 

the widget you want from the Add New Widget dialogue. In this dialogue you can search for a 

widget name or use one of the categories on the left. Alternatively, you can right click in the 

editor where you’d like to insert the widget and type in the widget’s name where it says Search 

Widgets. 

Editing a Widget 
You can edit a widget by clicking on the widget either in the editor or on the live preview. An 

edit dialogue will appear. At the very top left next to the widget icon, you can type an optional 

label describing the widget. This label will only be shown on the Layout Builder and helps you to 

https://siteorigin.com/page-builder/documentation/
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stay organized. On the top right you’ll see a left, right, and close button. You can use the left 

and right buttons to navigate through different widgets. Both the close button and the Done 

button on the bottom right will save your changes and close the editing dialogue. On the 

bottom left are links to Delete and Duplicate the widget. On the left side of the dialogue will be 

the widget specific options. For more details on specific widgets see Using the SiteOrigin 

Widgets Bundle or Using the Bootstrap Widgets Bundle. Often at the bottom of the widget 

specific settings there will be a Preview button. Clicking this will open a preview of that widget 

which can be closed by clicking the back icon in the top right corner. On the right of the 

dialogue will be the Widget Styles. For documentation on Widget Styles see Widget Styles. 

Widget Styles 
These styles are split up into three categories Attributes, Layout, and Design. Under Attributes 

you can add a custom widget ID, widget CSS class, CSS styles, and mobile CSS styles. These are 

all HTML and CSS styles and should only be used by an advanced user. In Layout you can 

change margin, padding, and mobile padding CSS styles. While these are CSS styles, you may 

need to use these options. Padding provides spacing around a widget. You can choose the 

amount of padding on any side by typing a number into the corresponding text field. I would 

recommend using the number 15 for spacing and I would have the dropdown below set to px 

(pixels). Under Design you can set a background color, background image and how it’s 

displayed, border color, default font color, and default link color. Some widgets will override 

the default font and link colors. 

Moving a Widget 
Moving widgets is super easy. Using the Layout Builder, simply click and drag the widget to 

where you want to move it and release the mouse. 

Duplicating a Widget 
To duplicate a widget, right click on the widget and click Duplicate Widget. This will add a 

duplicate of the widget directly under this widget. 

Deleting a Widget 
To delete a widget, right click on the widget and click Delete Widget then click Are you sure? to 

confirm. Don’t worry, you can always undo this using the History button at the top of the 

Layout Builder. 
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Rows 
Rows help you organize your widgets and fit more onto one screen. Here we’ll describe how to 

create, edit, move, duplicate, and delete rows. 

Creating a Row 
To create a row click Add Row and edit the row in the Add New Row dialogue. For details on 

how to edit rows see Editing a Row. Alternatively, you can right click in the editor and under 

Add Row click 1 Column, 2 Column, 3 Column, or 4 Column to insert a prebuilt row. 

Editing a Row 
You can edit a row by hovering over the wrench and clicking Edit Row or by right clicking on the 

row and clicking Edit Row. An edit dialogue will appear. At the very top left next to the row 

icon, you can type an optional label describing the row. This label will only be shown on the 

Layout Builder and helps you to stay organized. (Additionally, you can change the color of the 

row to stay organized. You can do this by hovering over the wrench on the Layout Builder and 

clicking the desired color.) On the top right you’ll see a close button. Both the close button and 

the Done button on the bottom right will save your changes and close the editing dialogue. On 

the bottom left are links to Delete and Duplicate the row. On the top of the dialogue you’ll see 

options to choose the number of rows, the size of each, and how the sizing is assigned. 

Additionally, you can resize rows by dragging the divider in between them. You can also click on 

the percentages and edit them manually. On the right of the dialogue will be the Row Styles. 

For documentation on Row Styles see Row Styles. 

Row Styles 
These styles are split up into three categories Attributes, Layout, and Design. Under Attributes 

you can add a custom row ID, row CSS class, CSS styles, and mobile CSS styles. These are all 

HTML and CSS styles and should only be used by an advanced user. In Layout you can change 

the margin, gutter, padding, mobile padding CSS styles as well as the row layout, collapse 

behavior, collapse order, and cell vertical alignment. While these are CSS styles, you may need 

to use these options. Bottom Margin sets the spacing below the row. Gutter sets the spacing 

between row columns. Padding provides spacing around a widget. You can choose the amount 

of margin, gutter, and padding by typing a number into the corresponding text field. I would 

recommend using the number 15 for spacing and I would have the dropdown below set to px 

(pixels). Row Layout allows you to expand the content to the end of the screen by selecting Full 

Width Stretched. By default, columns become stacked on tablet and mobile devices. By setting 

Collapse Behavior to No Collapse you can prevent this from happening. Collapse Order specifies 
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which column goes on top on tablet and mobile devices. Cell Vertical Alignment specifies how 

to vertically align content in the columns. Under Design you can set a background color, 

background image and how it’s displayed, and the border color. Additionally, if you click on 

each row, at the bottom of the Row Styles you’ll see more style options for the selected 

column. 

Moving a Row 
Moving row is super easy. Using the Layout Builder, simply click and drag the move icon next to 

the wrench icon to where you want it and release the mouse. 

Duplicating a Row 
To duplicate a row, right click on the row and click Duplicate Row. This will add a duplicate of 

the row directly under this row. 

Deleting a Row 
To delete a row, right click on the row and click Delete Row then click Are you sure? to confirm. 

Don’t worry, you can always undo this using the History button at the top of the Layout Builder. 

Layouts 
Clicking the Layouts button at the top of the Layout Builder will open the Page Builder Layouts 

dialogue. Here you can browse SiteOrigin’s Layout Directory for pre-built layouts, import or 

export layouts, or clone posts and pages that are using SiteOrigin Page Builder. When you find 

one you like, click Insert and then choose whether you want the new layout added before, 

after, or instead of the current Layout Builder’s content. Again, you can always undo this using 

the History button at the top of the Layout Builder. 

History 
The Page Builder Change History dialogue allows you to view and restore older versions of the 

content. You can open the dialogue by clicking History at the top of the Layout Builder. 

Restoring versions is as easy as clicking on the version you want and clicking Restore Version. 

Live Editor 
The Live Editor is useful for previewing your content as you edit. It can be super helpful, but the 

preview can take a while to load. All other features in the Layout Builder work the same in the 

live editor. The live editor can also be loaded directly from viewing a page by clicking Live Editor 

on the admin bar. When using Live Preview make sure you click Done and then Save 

Draft/Publish/Update to save the changes.  
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Using the SiteOrigin Widgets 
Bundle 
The SiteOrigin Widgets Bundle provides widgets to be used with Page Builder by SiteOrigin. 

Activating Widgets 
To use any of the widgets in this widget bundle both Page Builder by SiteOrigin and the 

SiteOrigin Widgets Bindle plugin must be installed and active. Once active, navigate to the 

SiteOrigin Widgets Bundle page (Plugins → SiteOrigin Widgets) and Active all the plugins you 

want to use on this site. All active plugins will now show up in Page Builder. 

Recommended Resources: 

https://siteorigin.com/widgets-bundle/getting-started/#heading-widgets-management 

Widgets 
SiteOrigin provides their own documentation for their widgets that should be kept up to date. 

To view the full SiteOrigin Widgets Bundle documentation visit https://siteorigin.com/widgets-

bundle/getting-started/. Some documentation will be provided below for commonly used 

SiteOrigin widgets. 

SiteOrigin Editor 
The SiteOrigin Editor widget is simply a text editor that’s identically to WordPress’ default post 

and page text editor. You can use this widget to add paragraphs, images, lists, and much more. 

Recommended Resources: 

https://siteorigin.com/widgets-bundle/editor-widget/ 

SiteOrigin Headline 
The SiteOrigin Headline widget is designed to be used at the top of a page and usually contains 

the page’s title. When using this widget to duplicate the other page title headlines, use the 

following settings: 

Set the text to the title of the page. 
Leave the HTML Tag at “H1”. 
Set the color to “#4b7c2a”. 
Set the font to “Kaushan Script”. 
 

https://siteorigin.com/widgets-bundle/getting-started/#heading-widgets-management
https://siteorigin.com/widgets-bundle/getting-started/
https://siteorigin.com/widgets-bundle/getting-started/
https://siteorigin.com/widgets-bundle/editor-widget/
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Set the padding to Top 46, Right 0, Bottom 32, Left 0. For help changing the padding see Widget Styles. 
  
Recommended Resources: 
https://siteorigin.com/widgets-bundle/headline-widget/  

https://siteorigin.com/widgets-bundle/headline-widget/
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Using the Bootstrap Widgets 
Bundle 
The Bootstrap Widgets Bundle was designed by Nathaniel Belsterling using Bootstrap 4.0 to be 

used with Page Builder by SiteOrigin. 

Activating Widgets 
To use any of the widgets in this widget bundle Page Builder by SiteOrigin, SiteOrigin Widgets 

Bindle, and the Bootstrap Widgets Bundle plugin must be installed and active. Once active, 

navigate to the SiteOrigin Widgets Bundle page (Plugins → SiteOrigin Widgets) and Active all 

the plugins you want to use on this site. All active plugins will now show up in Page Builder. 

Recommended Resources: 

https://siteorigin.com/widgets-bundle/getting-started/#heading-widgets-management 

Widgets 
Bootstrap Alert 
The Bootstrap Alert widget is designed to display a warning or urgent message at the top of a 

page, but it also has other uses. Within the editor for this widget you’ll find options for: 

Alert Color 
The background, font, and link colors are all styled by the widget. All you need to do is pick which color you 
want to use from the dropdown and the rest of the styles will be applied automatically. These colors will be 
the same across all Bootstrap widgets. Don’t forget you can preview the color using the Preview button 
without having to leave the editor dialogue. 
Alert Title 
This is the bold text that will appear at the top of the alert. 
Alert Text 
This is where you’ll type the text for the body of your alert. You can insert links using the text editor here. 
Dismissible 
If you would like an exit button on the top right of your alert to dismiss it, check this box. 
 

Bootstrap Blockquote 
The Bootstrap Blockquote widget is designed to feature a quote on the website. It will style the 

quote for you and has a place for a citation. Within the editor for this widget you’ll find options 

for: 

https://siteorigin.com/widgets-bundle/getting-started/#heading-widgets-management
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Blockquote Text 
Here you can type or paste the quote. 
Show Footer 
Check this checkbox to show what’s in the footer (the textbox below). 
Footer 
This is where you can add the author of the quote or a citation. 
Reverse 
The text and footer will align right if this checkbox is checked. 
 

Bootstrap Button 
The Bootstrap Button widget is simply a pre-styled button. The button can link to any content 

within the site or an external link. Within the editor for this widget you’ll find options for: 

Button Color 
The background and font colors are all styled by the widget. All you need to do is pick which color you want 
to use from the dropdown and the rest of the styles will be applied automatically. These colors will be the 
same across all Bootstrap widgets. For each color there’s a Solid and Outlined option. These are simply style 
differences. Also, the Link (Transparent) color option simply styles the button like a link. Don’t forget you can 
preview style changes using the Preview button without having to leave the editor dialogue. 
Link URL 
You can either type in a custom URL or click Select Content and pick from a list of posts and pages. If you’re 
linking a post or page be sure to use the Select Content option because the links will automatically update if 
the page ever gets moved. If you type in a custom link, make sure to update this if the link changes. 
Open in a new tab 
Check Open link in new tab if you want this link to open in a new tab. I would recommend checking this box 
for links to other sites. 
Button Text 
The text on the button. 
Button Size 
You can make the button bigger or smaller by selecting a different size. 
Fill Parent 
If checked, the button’s width will fill the container or row that it’s in. This setting may be difficult to preview 
in the Widget Preview because it depends on the container it’s in. 
Active (Indented) 
Check this to display the button as if it’s toggled on. You most likely won’t use this option. 
Disabled 
If checked, the button will be disabled and won’t be clickable. This can be used if you want to temporarily 
disable a button. 
Centered 
Check this to center the button in the parent. This setting may be difficult to preview in the Widget Preview 
because it depends on the container it’s in. 
 

Bootstrap Button Group 
A Bootstrap Button Group creates a group of styled buttons. This can be useful for in-page 

navigation links. Within the editor for this widget you’ll find options for: 
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Buttons 
Buttons can be added by clicking Add and they can be reordered by drag and drop. They can also be 
duplicated and deleted with the icons on the right. Click on the item you want to edit under Buttons to its 
settings. These button specific colors are the same as the button widget. 
Button Group Size 
You can make all the buttons bigger or smaller by selecting a different size. 
Fill Parent 
If checked, the button group’s width will fill the container or row that it’s in. This setting may be difficult to 
preview in the Widget Preview because it depends on the container it’s in. 
Vertical (Stacked) 
Check to stack the buttons vertically instead of horizontally. 
 

Bootstrap Callout 
The Bootstrap Callout widget is a container with a color on the left side and is useful for 

drawing attention to specific content or for color coding page content. 

Callout Color 
Pick which color you want to use for the left border from the dropdown and the styles will be applied 
automatically. These colors will be the same across all Bootstrap widgets. Don’t forget you can preview the 
color using the Preview button without having to leave the editor dialogue. 
Callout Builder 
Click Open Builder to open another Layout Builder. This allows you to add widgets and rows inside the callout. 
To learn how to use the Layout Builder see Using Page Builder by SiteOrigin. 
 

Bootstrap Card 
The Bootstrap Card widget is the most versatile widget in this bundle. It’s most used as a 

container to put content inside and can include a header, content, and a footer. 

Card Color 
The background, font, and footer colors are all styled by the widget. All you need to do is pick which color you 
want to use from the dropdown and the rest of the styles will be applied automatically. These colors will be 
the same across all Bootstrap widgets. For each color there’s a Solid and Outlined option. These are simply 
style differences. Don’t forget you can preview style changes using the Preview button without having to 
leave the editor dialogue. 
Card Header 
Show Header 
Check this to show the header. If this is not checked, none of the header will be visible even if the Card 
Header textbox is not empty. The Card Header and Card Title differ in style so test both out to see which on 
you’d like. 
Header Alignment 
You can specify how to align the Card Header text here. 
Card Header 
The header text. 
Card Image 
Show Image 
Check this to show the image. If this is not checked, no image will be displayed even if an image is selected. 
Choose an Image 
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Click Choose image to select the image you’d like to be displayed at the top of the card. You can also find one 
online using Image Search. 
Card Body 
Show Body Content 
Check this to show the Card Title and Card Text. If this is not checked, the Card Title and Card Text will not be 
displayed. This checkbox DOES NOT affect whether the Card Builder is displayed. (Even if you don’t have a 
Card Title or Card Text, you can leave this checkbox checked to add extra spacing around the Card Builder 
content.) 
Body Alignment 
You can specify how to align the Card Title and Card Text. 
Card Title 
The title text. 
Card Text 
Here you can type or paste the text inside this card. 
Card Builder 
Click Open Builder to open another Layout Builder. This allows you to add widgets and rows inside the card’s 
body. To learn how to use the Layout Builder see Using Page Builder by SiteOrigin. (The content in this builder 
will be displayed even if Show Body Content is not checked.) 
Card Footer 
Show Header 
Check this to show the footer. The footer is great for adding additional details related to the content of the 
card. If this is not checked, none of the footer will be visible even if the Card Footer textbox is not empty. 
Footer Alignment 
You can specify how to align the Card Footer text here. 
Card Footer 
The footer text. 
 

Bootstrap Feature 
The Bootstrap Feature widget is great for highlighting an image on one side of the screen and 

providing relevant content on the other side. Within the editor for this widget you’ll find 

options for: 

Choose an Image 
Click Choose image to select the image you’d like to be displayed one the side of your feature. You can also 
find one online using Image Search. 
Image Shape 
The image shape can provide style changes to the edges of the picture improving its appearance. I’d 
recommend leaving it on Corners Rounded or Circular (if it’s a square image) but feel free to test other 
options out and preview them using the Preview button. 
Display Order 
You can select whether the image appears on the left or right. 
Feature Builder 
Click Open Builder to open another Layout Builder. This allows you to add widgets and rows to the other side 
of the feature. To learn how to use the Layout Builder see Using Page Builder by SiteOrigin. 
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Bootstrap File Attachment 
The Bootstrap File Attachment widget is for inserting WordPress media directly into Page 

Builder and allows you to select an icon to describe what kind of file the button links to. Within 

the editor for this widget you’ll find options for: 

File Type 
You can select the file type and if the Icon Size isn’t set to Hidden an icon will automatically be added above 
the button showing what kind of media is linked. 
Icon Size 
You can choose how big the file type icon is. Set to Hidden if you don’t want an icon displayed. The icon will 
not be visible within the Widget Preview despite this setting. 
Choose a File 
Here you’ll select the file you want to attach from WordPress’ media library. 
Button Color 
The background and font colors are all styled by the widget. All you need to do is pick which color you want 
to use from the dropdown and the rest of the styles will be applied automatically. These colors will be the 
same across all Bootstrap widgets. For each color there’s a Solid and Outlined option. These are simply style 
differences. Also, the Link (Transparent) color option simply styles the button like a link. Don’t forget you can 
preview style changes using the Preview button without having to leave the editor dialogue. 
File Name 
Here you can customize the text on the button. I’d recommend something that describes the file like the file’s 
name. 
 

Bootstrap Header 
The Bootstrap Header widget is designed to be used at the top of a page and usually contains 

the page’s title. For consistency across the site, use the SiteOrigin Headline widget instead. 

Within the editor for this widget you’ll find options for: 

Header 
The large text on the top of the heading. Most of the time this will be the page’s title the Header is on. 
Show Subheader 
Choose whether to show or hide the Subheader. If this is not checked, none of the subheader will be visible 
even if the Subheader textbox is not empty. 
Show Divider 
If checked, a horizontal line will be added after the subheader. 
 

Bootstrap Image Button 
The Bootstrap Image Button widget features an image with a button at the bottom. The button 

is partially transparent, so no color options exist. Within the editor for this widget you’ll find 

options for: 

Choose an Image 
Click Choose image to select the image you’d like to be displayed one the side of your feature. You can also 
find one online using Image Search. 



 

  

LAST REVISED 5/16/2018 28 

 

Button Text 
The text to be displayed on the button. 
Link URL 
You can either type in a custom URL or click Select Content and pick from a list of posts and pages. If you’re 
linking a post or page be sure to use the Select Content option because the links will automatically update if 
the page ever gets moved. If you type in a custom link, make sure to update this if the link changes. 
Open in a new tab 
Check Open link in new tab if you want this link to open in a new tab. I would recommend checking this box 
for links to other sites. 
Fly in on Scroll 
If this is checked, the button will do a fly in animation from the bottom when scrolled into view. This setting 
will not affect the Widget Preview. 
 

Bootstrap Lead Paragraph 
The Bootstrap Lead Paragraph widget is useful for featuring text. It applies special stylings to 

the paragraph. Within the editor for this widget you’ll find options for: 

Lead Paragraph 
You can type or paste your featured text here. You can’t have multiple paragraphs within this widget without 
adding the HTML <br> where you want to start a new paragraph. 
Text Align 
You can specify how to align the paragraph here. 
Choose a Size 
Here you can set your paragraph size to small, medium, or large. 
 

Bootstrap List Group 
The Bootstrap List Group widget is used to create a styled list of items. Each item in the list can 

function as a link as well. Most of the time you’ll want to use the SiteOrigin Editor widget inside 

the Item Builder. Within the editor for this widget you’ll find options for: 

Items 
Items can be added by clicking Add and they can be reordered by drag and drop. They can also be duplicated 
and deleted with the icons on the right. Click on the item you want to edit under Items to see its settings. 
Each item has the following options: 
Item Color 
The background, font, and link colors are all styled by the widget. All you need to do is pick which color you 
want to use from the dropdown and the rest of the styles will be applied automatically. These colors will be 
the same across all Bootstrap widgets. Don’t forget you can preview the color using the Preview button 
without having to leave the editor dialogue. 
Make Item a Link 
Check this to make the item a link. If this checkbox is not checked, the Link URL won’t be applied even if the 
textbox isn’t empty. 
Link URL 
You can either type in a custom URL or click Select Content and pick from a list of posts and pages. If you’re 
linking a post or page be sure to use the Select Content option because the links will automatically update if 
the page ever gets moved. If you type in a custom link, make sure to update this if the link changes. 
Item Builder 
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Click Open Builder to open another Layout Builder. This allows you to add widgets and rows inside this item. 
To learn how to use the Layout Builder see Using Page Builder by SiteOrigin.  
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Customizing the Sequanota 
Theme 
Changing the Title, Tagline, and Icon 
To change the site identity (the title, tagline, and icon), open the customizer by selecting 

Customize from The Admin Bar. Inside the editor on the left, click Site Identity and then make 

the desired changes. The changes should be applied in the preview on the right. To apply them 

to the site click Publish at the top. If you wish to discard the changes, click the Settings icon next 

to Publish and then click Discard changes. It will ask you to confirm, click Ok. Click the Settings 

icon again to close that dialogue. 

Changing the Theme Colors 
You can change the colors of the top navigation, the footer, and the Back to Top button. To edit 

these theme options, open the customizer by selecting Customize from The Admin Bar. Inside 

the editor on the left, click Theme Options then click Select Color under the setting you wish to 

change. The changes should be applied in the preview on the right. To apply them to the site 

click Publish at the top. If you wish to discard the changes, click the Settings icon next to Publish 

and then click Discard changes. It will ask you to confirm, click Ok. Click the Settings icon again 

to close that dialogue. 

Changing the Donate Now Link 
You can change where the Donate Now button goes in the customizer. To open the customizer, 

select Customize from The Admin Bar. Inside the editor on the left, click Theme Options then 

click changes the Donate Button Link text. The changes should be applied in the preview on the 

right. To apply them to the site click Publish at the top. If you wish to discard the changes, click 

the Settings icon next to Publish and then click Discard changes. It will ask you to confirm, click 

Ok. Click the Settings icon again to close that dialogue. 

Editing the Footer 
You can edit the footer using the customizer. To open the customizer, select Customize from 

The Admin Bar. Inside the editor on the left, click Widgets and then click Layout Builder. Next 

click Open Builder. Here you have a complete Layout Builder for the footer and you can 

customize it like any other Layout Builder. For more details see Using Page Builder by SiteOrigin. 
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Styling Best Practices 
Spacing at the Bottom of Pages 
When making a page, you should add the following padding, and mobile padding values in 

pixels (px) to the last row on the page. For more details on changing the last row’s styles, see 

Row Styles. 

Padding: Top 0, Right 0, Bottom 30, Left 0 
Mobile Padding: Top 0, Right 0, Bottom 15, Left 0 
 

Page Headers 
For details on adding the page title to the top pages, see SiteOrigin Headline.  
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Using the Donation 
Thermometer Plugin 
This plugin adds a widget that can be used in Page Builder by SiteOrigin, but it does not need to 

be activated link the other widget bundles. Once the plugin has been installed and activated, 

see Plugins (Plugins → Installed Plugins), you can add a donation thermometer to your site by 

pasting the following shortcode into a text editor (most likely the SiteOrigin Editor widget). 

[thermometer raised=1523 target=5000 width=200 height=567 align=left] 
You can change the values after the equal sign to change the respective option. 
Raised – the amount of money raised so far. 
Target – the monetary goal of the fundraiser. 
Width – the width of the thermometer in pixels. Can also be a percentage. Ex: 20% 
Height – the height of the thermometer in pixels. Can also be a percentage. Ex: 20% 
Align – how you want the content to be aligned. Acceptable values include left, right, or center. 
There are other options available by these are the only ones you will need.  
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Other Plugins 
Add Menu Separators to Navigation 
This plugin manages the divider for menus, see Editing Menus Using the Customizer for more 

details. This plugin has no settings. 

Deeper Comments 
This plugin styles and runs the comments section of the site. Please DO NOT disable this widget 

if you wish to continue using comments on posts or pages. You shouldn’t need to edit its 

settings but if needed feel free to change them (Deeper → Settings). You can always revert 

them to their defaults by clicking Reset All in the top right-hand corner. 

Duplicator 
This plugin is used to backup the site. You can do this on Duplicator’s Packages page (Duplicator 

→ Packages). 

Google XML Sitemaps 
This plugin helps Google and other search engines index your site for content. Please do not 

change any of this plugin’s settings as they could affect how search engines view your content. 

Stream 
Stream Records is a plugin that keeps track of website login attempts, post and page edits, 

plugin updates, and much more. Keep this plugin running to ensure a history of changes to your 

site. This will be especially helpful if anything ever breaks as it provides a history of when the 

incorrect changes were made. You can change what the plugin logs on its settings page (Stream 

→ Settings). 


